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Teacher Guide

Tracking Change Over Time: Getting Started
Time Estimate: one class period, up to 1 hour

Suggested grade levels: 5–8

Materials needed: projection system (computer with projector 
or SMART Board)

Vocabulary: satellite, Landsat, change pair

Next Generation Science Standards

• Analyzing and Interpreting Data
• Analyze and interpret data to determine similarities and 

differences in findings. (MS-ESS3-2)
• PS4.B: Electromagnetic Radiation

• When light shines on an object, it is reflected, absorbed, 
or transmitted through the object, depending on the 
object’s material and the frequency (color) of the light. 
(MS-PS4-2)

• ESS3.B: Natural Hazards
• Mapping the history of natural hazards in a region, 

combined with an understanding of related geologic 
forces can help forecast the locations and likelihoods of 
future events. (MS-ESS3-2)

• ESS3.C: Human Impacts on Earth Systems
• Human activities have significantly altered the biosphere, 

sometimes damaging or destroying natural habitats and 
causing the extinction of other species. But changes 
to Earth’s environments can have different impacts 
(negative and positive) for different living things. 
(MS-ESS3-3)

• Typically as human populations and per-capita 
consumption of natural resources increase, so do 
the negative impacts on Earth unless the activities 
and technologies involved are engineered otherwise. 
(MS-ESS3-3), (MS-ESS3-4)

National Science Education Standards (NSES)

• Science in Personal and Social Perspective:
• Populations, resources, and environments
• Natural hazards

American Association for the Advancement of Science  
(AAAS) Benchmarks

• Physical Setting/Processes that Shape the Earth/
Interdependence of Life; Use of Earth’s Resources; 
Weather and Climate (4C/M7) Human activities, such as 
reducing the amount of forest cover, increasing the amount 
and variety of chemicals released into the atmosphere, and 
intensive farming, have changed the earth’s land, oceans, 
and atmosphere. Some of these changes have decreased the 
capacity of the environment to support some life forms.

National Geographic Education Standards

• Standard 14: “Environmental modifications have economic, 
social, and political implications for most of the world’s 
people. Therefore, the geographically informed person  
must understand the reasons for and consequences of  
human modifications of the environment in different parts  
of the world.”

Overview
The Tracking Change Over Time lesson plan includes  
four parts:

• Getting Started
• Understanding Remote Sensing
• Using MultiSpec to Interpret Satellite Imagery
• The modules

Once students learn the basics of remote sensing and how to 
use the MultiSpec software, they can delve deeper into specific 
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topics with the individual modules. These modules demonstrate 
the uses of satellite data to track different types of landscape 
change over time. Students will be able to see how scientists 
compare images like these to learn more about changes taking 
place in a region.

The lesson includes two modules: “Urban Area Change—
Phoenix, AZ” and “River Flooding.” Subsequent modules will 
address other types of land change including natural hazards, 
land use change, and climate change. Watch for new module 
releases and add to this lesson plan!

Getting Started demonstrates the many uses of satellite images, 
using several Landsat images that will grab your students’ 
attention and clearly show that landscape change can be 
immediate and dramatic.

Learning Goals

Students will
• Recognize that scientists use satellite imagery to understand 

how the Earth’s surface changes over time.
• Learn that satellite images reveal a multitude of details about 

the land surface.

Procedures

• National Aeronautics and Space Administration (NASA) 
Landsat Flyby video

• You may choose to begin the lesson with this 2-minute 
video, which highlights Landsat’s many benefits to 
society. (The file is called “NASA_A Landsat Flyby.
mp4” and is available at http://eros.usgs.gov/educational-
activities under “Tracking Change Over Time – 
Teacher.”)

• Earthshots images
• Show the Earthshots images and explain what these 

change pairs show. The Earthshots PDF, which has 
background information, is available at http://eros.usgs.
gov/educational-activities (New Earthshots trading 
cards).

• Use the USGS Earthshots Web site to show even more 
information about how satellite imagery is used to track 
change over time: http://earthshots.usgs.gov/earthshots.

• Or print out the images and randomly hand them out 
to the students. Students can then examine the images 
and information and exchange with one another until 
they have viewed all of the image pairs. Allow students 
to discuss in teams of 2–4. Instruct students to look 
for lakes, rivers, bays, roads, urban areas, farmlands, 
forests, mountains, and airports. Students should 
discuss features that different change pairs may have 
in common. They could also discuss why each change 
pair was chosen to be featured on these cards. Students 
will gain some beginning background information about 
satellite imagery and what it shows us about the changing 
landscape.

• The lesson includes several more dramatic Landsat images, 
which are available at http://eros.usgs.gov/educational-
activities (each .tif file begins with the filename “Intro_
image”). Display each one on the screen. Ask students where 
in the world each image is from and what features they see. 
Refer to the Word document “Introduction_Images.doc” for 
some background information and prompts for each image.

• Discussing various colors and features in these images will 
enhance learning by providing background for the other 
activities in this lesson.

Resources
Achieve, Inc., 2015, Next Generation Science Standards: 

accessed November 20, 2015, at http://www.
nextgenscience.org/next-generation-science-standards. 

American Association for the Advancement of Science 
(AAAS), 2007, Atlas of Science Literacy—Project 2061: 
Washington, D.C.

National Aeronautics and Space Administration, 2010, Tour of 
the electromagnetic spectrum: National Aeronautics and 
Space Administration, accessed November 20, 2015, at 
http://missionscience.nasa.gov/ems.

National Academies Press, 1996, National Science Education 
Standards (NSES): Washington, D.C., National Academy 
Press, accessed November 20, 2015, at http://www.nap.edu/
openbook.php?record_id=4962.

National Geographic, 2008, National Geographic Xpeditions—
Geography standards: U.S. National Geography Standards, 
accessed November 20, 2015, at http://education.
nationalgeographic.org/standards/national-geography-
standards/.

U.S. Geological Survey, 2015, Land Remote Sensing 
Program home page: accessed November 20, 2015, at 
http://remotesensing.usgs.gov.

U.S. Geological Survey, 2015, Earthshots—Satellite images of 
environmental change: Sioux Falls, S.Dak., U.S. Geological 
Survey Earth Resources Observation and Science Center, 
accessed November 20, 2015, at http://earthshots.usgs.gov.

Please send us your ideas and feedback about this lesson:

U.S. Geological Survey
Earth Resources Observation and  
  Science (EROS) Center

47914 252nd Street
Sioux Falls, SD  57198
(800) 252-4547
(605) 594-6511

http://eros.usgs.gov
custserv@usgs.gov

An electronic version of this packet, image files, the MultiSpec software, and related documents are available for download at  
http://eros.usgs.gov/educational-activities
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Teacher Guide

Tracking Change Over Time: Understanding Remote Sensing
Time Estimate: 1–2 class periods

Suggested grade levels: 5–8

Materials needed: projection system (computer with projector 
or SMART Board)

Vocabulary: remote sensing, pixel, resolution, electromagnetic 
energy, electromagnetic spectrum, infrared, wavelength

Next Generation Science Standards

• Analyzing and Interpreting Data
• Analyze and interpret data to determine similarities and 

differences in findings. (MS-ESS3-2)
• PS4.B: Electromagnetic Radiation

• When light shines on an object, it is reflected, absorbed, 
or transmitted through the object, depending on the 
object’s material and the frequency (color) of the light. 
(MS-PS4-2)

• ESS3.C: Human Impacts on Earth Systems
• Human activities have significantly altered the biosphere, 

sometimes damaging or destroying natural habitats and 
causing the extinction of other species. But changes 
to Earth’s environments can have different impacts 
(negative and positive) for different living things. 
(MS-ESS3-3)

• Typically as human populations and per-capita 
consumption of natural resources increase, so do 
the negative impacts on Earth unless the activities 
and technologies involved are engineered otherwise. 
(MS-ESS3-3), (MS-ESS3-4)

National Science Education Standards (NSES)

• Science in Personal and Social Perspective:
• Populations, resources, and environments
• Natural hazards

American Association for the Advancement of Science  
(AAAS) Benchmarks

• Physical Setting/Motion/Waves (4F/M5) Human 
eyes respond to only a narrow range of wavelengths 
of electromagnetic waves-visible light. Differences of 
wavelength within that range are perceived as  
differences of color.

National Geographic Education Standards

• Standard 14: “Environmental modifications have economic, 
social, and political implications for most of the world’s 
people. Therefore, the geographically informed person  
must understand the reasons for and consequences of  
human modifications of the environment in different  
parts of the world.”

Overview
Activities lead students to an understanding of what remote 
sensing means and how researchers use it to study changes to 
the Earth’s surface. Consider the following steps as a sequence, 
each section building on the previous ones. Nevertheless, these 
steps are flexible; feel free to adapt the sequence or only cover 
the steps that are relevant to your class.

Learning Goals

Students will
• Learn how sensors onboard Earth-observing satellites work 

and how to identify features in a satellite image.
• Learn about the history of the Landsat satellites.
• Investigate how pixels and resolution relate to  

satellite imagery.
• Use the tools that scientists use to analyze and interpret 

satellite imagery to investigate changes over time.

1. What is remote sensing?

Remote sensing means observing something from a distance. 
Satellites in space observe the Earth from a distance and help 
scientists study large tracts of land and how that land changes 
over time.
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Optical remote sensing satellites use reflected light to detect 
electromagnetic energy on the Earth’s surface. The level of 
energy is represented by the electromagnetic spectrum, which is 
the range of energy that comes from the Sun. The light from the 
Sun that we can see is only a small part of the electromagnetic 
spectrum and includes the colors of the rainbow. Satellite 
sensors can detect light that we can’t see.

The electromagnetic energy reflects off the Earth’s surface and 
up to the satellite sensor, which collects and records information 
about that energy. That information is transmitted to a receiving 
station in the form of data that are processed into an image.

While there are many Earth-observing satellites, these lessons 
focus on the Landsat series of satellites. The Landsat satellites 
are in a polar orbit, which, along with the Earth’s rotation, 
allows them to image most of the Earth. As a Landsat satellite 
revolves around the Earth, its sensor “sees” a certain portion of 
the Earth’s surface. As the satellite orbits the Earth from pole to 
pole, it appears to move from east to west because of the Earth’s 
rotation. This apparent movement allows the satellite to view a 
new area with each orbit.

2. How do satellite sensors work?

We can only see an object because light bounces off of it and to 
our eyes. Human eyes can detect only visible light—the colors 
of the rainbow. Satellite sensors can also detect ultraviolet and 
infrared light.

The sensors record this information in different portions of the 
electromagnetic spectrum, which is measured in wavelengths. 
Landsat satellite sensors detect both visible and infrared light.

When satellite images are made, these “invisible” types of light 
are assigned visible colors to represent them. That is why some 
satellite images have strange colors.

3. What can you see in a satellite image?

In this image of Bellingham, Washington (right), you can see a 
river (A), urban areas (B), agricultural areas (C), and forest (D). 
(This image is available at http://eros.usgs.gov/educational-
activities so you can open it and display with a projector or 
SMART Board, both with and without labels. The filename is 
Bellingham.tif.) See if you can find the following features in the 
image:
• Airport E
• River sediment F
• Bay G
• Lake H
• Major streets I
• Highway J
• Logging clear-cut areas K
• Golf course L
• Cleared area for power lines M

4. The Landsat series

This section contains some of the basic facts about the Landsat 
series of satellites. Students could read it on their own, or you 
could highlight certain information.

Landsat Uses:

• Geographers look for changes on the Earth’s surface that 
need to be mapped.

• Foresters need information about what type of trees are 
growing and if they have been affected by disease, fire,  
or pollution.

• Environmental scientists detect, identify, and follow the 
movement of pollutants such as oil slicks on the ocean.

• Geologists are interested in finding valuable minerals.

• Farmers monitor how crops are growing and if they have 
been affected by drought, floods, disease, or pests.

• Ship captains plot the best route through polar ice packs.

• Firefighters send out crews based on information about  
the size and movement of a forest fire.
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Since 1972, the Landsat series of Earth-observing satellites 
has been imaging Earth’s land areas. Landsat represents the 
world’s longest continuously acquired collection of space-based 
moderate resolution land remote sensing data. Landsat imagery 
provides a unique resource for those who work in agriculture, 
geology, forestry, regional planning, education, mapping, and 
global change research. Landsat images are also invaluable for 
emergency response and disaster relief.

The Landsat satellites are launched by NASA at Vandenberg 
Air Force Base, California. Once the satellite is in orbit, the 
U.S. Geological Survey (USGS) is responsible for processing 
and storing (archiving) the satellite data. The USGS Earth 
Resources Observation and Science (EROS) Center in Sioux 
Falls, SD, archives and distributes the satellite data.

The two Landsat satellites currently operating are Landsat 7 and 
Landsat 8. They are in a polar orbit 705 kilometers (438 miles) 
above the Earth’s surface. They complete 1 orbit every 
99 minutes, for 14 ½ orbits per day. This means it takes 16 days 
for each satellite to obtain imagery over the entire globe.

5. Identifying Changes over Time

The Landsat satellite image collection is valuable because it 
shows change over time of the Earth’s land surfaces. Look at 
these two images and find at least five things that have changed 
between the two time periods. (The images are available at 
http://eros.usgs.gov/educational-activities so you can open them 
and display with a projector or SMART Board. The filenames 
are Salt_Lake_City_1985.jpg and Salt_Lake_City_2015.jpg.)

A

E

F

G H

I

J

K

M

L

B

C D

Satellite Launched Decommissioned
Landsat 1 July 23, 1972 January 6, 1978
Landsat 2 January 22, 1975 February 25, 1982
Landsat 3 March 5, 1978 March 31, 1983
Landsat 4 July 16, 1982 June 15, 2001
Landsat 5 March 1, 1984 2013
Landsat 6 October 5, 1993 Did not achieve orbit
Landsat 7 April 15, 1999 Still operating
Landsat 8 February 11, 2013 Still operating
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Landsat 5, Salt Lake City, Utah, August 31, 1985.

• Salt Lake City International Airport, top center, has changed, 
especially the addition of a runway on the west side.

• Numerous urban areas have expanded, especially to the west 
and southwest.

• The 2015 image contains several more golf courses than the 
1985 image. See if students can locate a few of them.

• In the northeast corner of the images, a new lake appears, the 
Little Dell Reservoir.

• In the southwest corner of the images is the Bingham Canyon 
Open Pit Copper Mine, the largest man-made excavation in 
the world. Some expansion to the mine can be seen on the 
north side of the pit.

• The large pink and blue shape in the northwest corner of 
the images is the tailings pond for the copper mine. Tailings 
are the waste left over from refining the copper. This is a 
continuously changing landform. 

• Ask students what other changes they notice.

6. Types of Change

Brainstorm examples of short-term and long-term changes to 
the Earth’s surface.

Ask students for their ideas and record them on the board. Then 
ask students the following questions for class discussion:
• Which of these changes are likely to affect your life and why?
• How could these changes be studied? (Visiting the site to see 

the change, satellite images, reading about the place.)

Landsat 8, Salt Lake City, Utah, September 19, 2015.

• What are the advantages and disadvantages of how these 
changes can be studied? (Some ideas to address: Visiting the 
site can be costly and in some cases impossible—the location 
could be too remote. Visiting the site only lets you see a small 
area; satellite images allow you to see more area. Satellite 
images can be expensive; however, Landsat images are freely 
available to the public online at http://glovis.usgs.gov/.)

• How can images from remote sensing satellite sensors help 
us study landscape changes on the Earth’s surface? (People 
can see large areas and observe how a place changes over 
months, years, or decades.)

7. What is a pixel?

The resolution of the Landsat satellite data we are using is 
30 meters. That means one pixel is equal to a square 30 meters 

Short-term changes Long-term changes

weather river changing course
forest fire urban area expanding
crops growing & harvested deforestation
leaves falling off trees lake drying up
volcanic eruption melting glaciers
mining
building a dam

10

http://glovis.usgs.gov/


by 30 meters, which is about the size of a baseball diamond. 
For example, one Landsat 5 image contains about 35 million 
pixels—that’s about 35 million baseball diamonds!

Extra hands-on activity: Have the students measure off 
a 30x30-meter area to show the size of the surface area 
of one Landsat pixel. For this exercise, the classroom 
may be too small and you may need to use the gym or 
the schoolyard. This exercise helps the students directly 
visualize the size of a Landsat pixel.

Let’s see how a low-resolution image compares to a high-
resolution image. On the blank grids, try to create the letter R on 
the 5x5 grid. (These grids are available at http://eros.usgs.gov/
educational-activities.) Only whole squares may be used; no 
diagonals or partial filling allowed. How well does this work? 
Try a grid with more squares/pixels. Which grid works best for 
this task, the 5x5, 10x10, or 30x30? Which one produces the 
best picture?

Ask the students to explain why the set of smaller blocks 
produced a better image. Students should recognize that the 
smaller the amount of space in a pixel, the sharper the final 
image will be. But note that the image with small pixels took 
a lot more work and time to complete. So we need a happy 
medium—enough detail to be able to observe landscape change 
but not too much that it is impractical to work with. The 
30-meter resolution of Landsat is that happy medium.

The 30-meter resolution of Landsats 7 and 8 works well for 
observing landscape changes over time. Bigger pixels wouldn’t 
provide enough detail, and smaller pixels would be too much 
data to be practical to work with. Remote sensing scientists 
refer to this as moderate resolution. Other Earth-observing 
satellites, such as NASA’s Terra and Aqua satellites, have lower 
resolutions, up to 1 kilometer. And France’s Satellite Pour 
l’Observation de la Terre (SPOT) has higher resolutions, up to 
2.5 meters.
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Resources
Achieve, Inc., 2015, Next Generation Science Standards: 

accessed November 20, 2015, at http://www.
nextgenscience.org/next-generation-science-standards. 

American Association for the Advancement of Science 
(AAAS), 2007, Atlas of Science Literacy—Project 2061: 
Washington, D.C.

Canada Centre for Remote Sensing, 2007, Fundamentals of 
remote sensing: Natural Resources Canada, accessed 
November 20, 2015, at http://www.nrcan.gc.ca/earth-
sciences/geomatics/satellite-imagery-air-photos/satellite-
imagery-products/educational-resources/9309. 

National Aeronautics and Space Administration, 2010, Tour of 
the electromagnetic spectrum: National Aeronautics and 
Space Administration, accessed November 20, 2015, at 
http://missionscience.nasa.gov/ems.

National Aeronautics and Space Administration, 2005, Play 
Pixel This!: National Aeronautics and Space Administration 
accessed November 20, 2015, at http://spaceplace.nasa.
gov/pixel-this/en/. 

National Academies Press , 1996, National Science Education 
Standards (NSES): Washington, D.C., National Academy 
Press, accessed November 20, 2015, at http://www.nap.edu/
openbook.php?record_id=4962. 

National Geographic, 2008, National Geographic Xpeditions—
Geography standards: U.S. National Geography Standards, 
accessed November 20, 2015, at http://education.
nationalgeographic.com/standards/national-geography-
standards/. 

U.S. Geological Survey, 2012, Landsat—A global land-imaging 
mission: U.S. Geological Survey Fact Sheet 2012–3072, 
4 p., accessed November 20, 2015, at http://pubs.usgs.gov/
fs/2012/3072/. 

U.S. Geological Survey Earth Resources Observation and 
Science (EROS) Center, 2015, U.S. Geological Survey 
EROS home page: accessed November 20, 2015, at 
http://eros.usgs.gov. 

U.S. Geological Survey, 2015, Earthshots—Satellite 
images of environmental change: Sioux Falls, S. Dak., 
U.S. Geological Survey Earth Resources Observation and 
Science Center, accessed November 20, 2015, at  
http://earthshots.usgs.gov. 

U.S. Geological Survey, 2015, Landsat Missions home page: 
accessed November 20, 2015, at http://landsat.usgs.gov.

U.S. Geological Survey, 2013, Landsat 8: U.S. Geological 
Survey Fact Sheet 2013–3060, 4 p., accessed November 20, 
2015, at http://pubs.usgs.gov/fs/2013/3060/. 
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Time Estimate: 1–2 class periods

Suggested grade levels: 5–8

Materials needed: projection system (computer with projector 
or SMART Board)

Vocabulary: RGB, band, additive color, subtractive color, false 
color, grayscale

Overview
This is a combination lesson and user guide for MultiSpec 
software (2015.2.12 Version), complete with instructions for 
running and using it.

Learning Goals

Students will
• Learn how the colors red, green, and blue (RGB) are used to 

create false color images from satellite data.
• Learn what band combinations are commonly used to reveal 

different details.
• Learn the basics of the MultiSpec software so they can open 

images, zoom in and out, find a particular latitude/longitude, 
change band combinations, crop images, and find the area of 
a selected region.

• Experiment on their own with a sample Landsat image.

MultiSpec Quick Launch

• Open a file
• File > Open Image

• Change band combinations
• Processor > Display Image
• Change the numbers under “Channels”

• Zoom
• Use the mountain buttons
• “X1.” for 100% size

• Show latitude-longitude
• Window > Show Coordinate View
• Change units in the drop-down menu at the upper left to 

“Lat-Long (Decimal)”
• Crop

• Select an area
• Processor > Reformat > Change Image File Format
• Save the cropped image, adding “.tif” to the end of  

the filename
• Open the new cropped image

1. Basics of RGB

Before we start opening and working with satellite images in 
MultiSpec, we need to understand more about how satellite 
sensors record images. All of the colors in a satellite image, 
similar to images on a television or computer monitor, are made 
up of a combination of red, green, and blue, or RGB for short.

The satellite sensors that captured the images you are studying 
record images in grayscale—each pixel is assigned a value of 
brightness on a scale from 0 to 255. Black is 0, and white is 
255, and shades of gray are in between. (Landsat 8 uses values 
of brightness on a scale from 0 to 4,095!) These grayscale 
images are assigned the color red, green, or blue, which display 

Teacher Guide

Tracking Change Over Time: Using MultiSpec to Interpret 
Satellite Imagery
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the brightness of each of these colors. When we combine the 
three images, we get a false color image. With all of the possible 
combinations of red, green, and blue values, this provides for 
a display system capable of providing over a million different 
colors. Try this color slider to see how this works: http://www.
calculatorcat.com/free_calculators/color_slider/rgb_hex_color_
slider.phtml. The color slider at this URL provides a fairly 
simple way of showing students how these three colors can  
be combined.

Stop and Check

• What happens when you set all three colors to the same 
value, such as 150? (you get gray, lighter gray with a  
higher number)

• What happens when you make all three colors equal to 255? 
(you get white)

• Try setting two of the colors to 255 and one to 0. In this color 
system, for example, red and green combine to make yellow. 
What other combinations do you notice?

Digging Deeper

Students might wonder, “whatever happened to yellow and blue 
make green?” We might have once learned about subtractive 
color, which is used in art. In subtractive color, the primary 
colors are yellow, blue, and red, and indeed yellow + blue = 
green. Satellite sensors, however, use the primary additive 
colors, which are red, green, and blue. The color slider  
shows the colors that result from combining the primary 
additive colors.

2. Band Combinations

Landsats 7 and 8 collect several images at once. Each image 
shows a specific section of the electromagnetic spectrum, called 
a band. The two tables below show the bands that Landsats 5 
and 7, and Landsat 8, collect.

Landsat 7 and Landsat 8 also use a panchromatic band. This band captures 
visible and infrared bands at 15-meter resolution and can be used to sharpen 
images from the other bands. We will not be dealing with the panchromatic 
band in this lesson.

Color slider
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Three of the bands are combined to form an image, each 
band assigned red, green, or blue in that order. Different band 
combinations reveal different details about the surface. In 
MultiSpec, you will be able to change the band combinations to 
help identify different features in satellite images.

3. Working Your Way around MultiSpec

1. Launch MultiSpec 
2.  Open the Reno image, which is a Landsat 7 image.

a. In the File menu, select “Open Image.”
b. In the Open dialogue box, locate the filename Reno.tif 

and click Open.
c. The “Set Display Specification for:” box will appear. 

The name of the image you opened will appear at the 
top of this box. Leave all of the defaults as they are and 
click OK.

d. The “Set Histogram Specifications” window appears; 
leave all of the default settings and click OK.
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i. You will only be able to enter numbers 1–7 
because there are 7 bands.

c. Click OK.
6. How to crop.

a. Click and hold while dragging the mouse to choose 
a rectangular area to crop. Watch the number under 
“Number pixels” as you drag; this is the number of 
pixels that will be in the cropped image. An area less 
than 3,000,000 pixels should fit on most screens.

f. Now you can zoom in on that lat-long and that point 
will stay in the center until you select another point.

5. How to change band combinations.
a. In the Processor menu, select “Display Image.”
b. In the “Set Display Specifications for:” dialogue box, 

change the numbers under “Channels.”

3. How to zoom (magnify the image)
a. Use the mountain buttons on the Tool Bar to zoom.

b. The large mountains zoom in, and the small mountains 
zoom out.

c. Hold down the Ctrl key to zoom slower.
d. Click “X1.” to make the image 100% in size.

4. How to find a particular latitude-longitude (lat-long)
a. In the Window menu, select “Show Coordinate View.”
b. In the drop-down menu at the upper left, change the 

units to “Lat-Long (Decimal).”

c. Move the mouse around over the image. Notice how 
the numbers change.

d. Keep moving the mouse until you are at the latitude-
longitude (lat-long) coordinates you want. A forest 
fire near Reno is at about 39.35° latitude, -120.00° 
longitude. Click once on the image when you are at 
these coordinates; you do not have to be too exact.

e. Now notice that the lat-long numbers on the right  
stay locked.
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b. In the Processor menu, choose “Reformat” and 
“Change Image File Format.”

c. In the “Set Image File Format Change Specifications” 
window, leave all of the default settings.

d. Click OK.
e. Choose where to save the new cropped image and give 

the image a filename, such as “cropped image 1.tif” 
(make sure the filename has “.tif” at the end).  
Click Save.

f. Open the image you just cropped (see Step 2).
i. In the “Set Display Specifications for:” window, 

you can choose the band combination you want to 
view, or just click OK.

ii. The “Set Histogram Specifications” window will 
appear next; leave all of the default settings and 
click OK.

g. Now it should be easier to see more detail in your 
image.

7. How to calculate area.
a. In the Window menu, select “Show Coordinate View.”
b. Click and hold while dragging the mouse to choose a 

rectangular area.
c. Next to “Number pixels” is a drop-down menu. Use 

this to select “Sq. kilometers” or another unit.

d. MultiSpec now displays how many square kilometers 
(or other unit) make up the area you selected.

8. How to save.
a. In the file menu, select “Save Image to GeoTIFF 

As…”

b. The “Save Active Image Window As:”  
window appears.

c. The filename has the band combination added.  
Click Save.

4. Experiment with the Reno image

Use the MultiSpec instructions and the suggested band 
combinations to answer the following questions about the  
forest fire near Reno, NV.

Students could write responses, or these questions could be used 
for class discussion.
• Look again at the table with the commonly used band 

combinations for Landsat 7. Which band combination shows 
most clearly the size of the area burned by the fire? (7,4,2; 
4,3,2; and 5,4,3 work well; however, 7,5,4 shows the burn 
area better.)
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• Which commonly used band combination shows most clearly 
the extent of smoke? (3,2,1—the band combination that is 
closest to natural color shows well the extent of the smoke 
and how it obscures Reno. The combination 4,3,2 shows the 
residential areas a little better, although it does not show the 
smoke as well.)

• Of the following band combinations, which one allows you 
to filter through the smoke and observe land surface features? 
7,5,3; 5,4,3; 7,4,1; 6,5,5; 4,2,1 (6,5,5 is best. Using band 5 
in both the green and blue wavelengths makes it possible to 
filter through the smoke. 7,5,3 also filters through enough 
smoke to show the urban areas slightly more clearly than 
6,5,5.)

• Of the following band combinations, which one shows where 
the fires were burning at the time of the image? 4,2,1; 6,5,5; 
7,5,3; 6,3,6; 5,3,2 (6,5,5 uses the thermal band to reveal the 
fires as the bright spots, and 7,5,3 will work well too. And 
5,3,2 shows both smoke and fire.)

• Of the following band combinations, which ones best show 
the urban area in this image? 3,2,1; 5,4,1; 7,5,3 (3,2,1 and 
5,4,1 are band combinations used for urban area studies, but 
in this image, smoke obscures Reno. 7,5,3 can be used here to 
see the extent of Reno’s urban areas.)

• Which commonly used band combination best shows 
agriculture and vegetation? (4,3,2 is a common band 
combination to use for vegetation studies—healthy vegetation 
appears red.)

• Imagine you are a remote sensing specialist living and 
working in Reno, and you are studying satellite images of 
this fire. Because the images show a lot of smoke, you want 
to send out warnings to residents about air quality. What 
direction is the smoke blowing at the time of this image? 
How can you tell? Which, if any, residential areas need to 
be warned? (The smoke is blowing generally east and north 
from the fire location, directly over the Reno urban area. 
Likely, a citywide message should go out about possible 
poor air quality, especially for people who have respiratory 
problems.)

• Challenge: Estimate the area, in square kilometers, that has 
been burned by the forest fire in this image. (See Step 7 in 
the previous section.) (A very rough estimate, based on a 
rectangular area centered on the burn area, is 45 to 50 square 
kilometers.)
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